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ARCHICAD 21 - INTUITIVITEIT
% Trapgereedschap

Overzicht werkwijze

» Trappen zijn vanaf ARCHICAD 21 geen bibliotheekelementen
meer.

» Modulaire opbouw zoals bij vliesgevels.

» Elke segment vrij te bewerken:
* Traptrede
» Stootbord
» Bordes
» Trapboom

- Afmetingen kunnen aan vaste regels gebonden worden.

» Het plaatsen is een tekenhandeling met directe visuele
feedback.

» Het plaatsen is zowel in het grondplan als in 3D mogelijk.
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Trapgereedschap

4

Intuitief modelleren zonder verlies van creatieve flow | | ~| ©
Wijze van modelleren is gelijk aan andere gereedschappen in ARCHICAD

Tekenen
* |nvoer door het tekenen van punten

* Preview wordt getoond tijdens het tekenen 1

» Wanneer niet kan worden voldaan aan de ingestelde regelgeving O Stair Solver

komt de Solver op o N Cannot create Stair using current
- ) Settings. Solutions:

E
RN
"<
2

Wijzigen -

* Wijzigingen via het Petpalet

 Wijzigen in elk venster van
ARCHICAD
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Reling gereedschap

% Associatief aan andere contructies
Wijze van modelleren is gelijk aan andere gereedschappen in ARCHICAD

Tekenen
* |Invoer door het tekenen van punten
* Preview wordt getoond tijdens het tekenen

Wijzigen
* Wijzigingen van het gekoppelde element wijzigt ook de reling
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Reling gereedschap

Andere mogelijkheden

Het reling gereedschap kan ook voor andere toepassingen gebruikt worden, zoals:
* Geprofileerde wanden,
 Dakspanten,
* Wegen/paden die het landschap (Mesh) volgen,
* enzovoort
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Bematen van composiet onderdelen

Dimension tool

» Nieuwe keuzemogelijkheden om individuele onderdelen van Composites te bematen.
1,000

» Kan gebruikt worden in de grondplannen, Gevels en Doorsneden.

810.5

» Vink de één of meerdere opties aan in de ‘Dimension Details’ in het Settings menu:

 Reference lines
 Core faces

» Quter faces
 of kies Manually dimension each skin

¥ -4 DIMENSION DETAILS

_1%1._ | Display the Height Always with Oversize
2 74 of Openings as well Always without Oversize

® Determined by Wiath

== | | Manually dimension each skin

o Automatically dimension Walls and Slabs

Outer faces

| Core faces

- Reference lines

Tip!
Gebruik de Geometriemethode ‘Single Click Thickness’ om met éen muisklik de Composiet te bematen.
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Bestanden splitsen

Selectie als *.pIln bestand opslaan

« Eenvoudige methode om grotere projecten op te splitsen naar één of meerdere bestanden.
» Deze bestanden kunnen automatisch omgezet worden naar Hotlink Modules.

- Elk apart *.pln bestand behoudt de volledige 2D inhoud zoals weergegeven in de Navigator,
Inclusief Layouts, Worksheets, Detalls

» via Menu File > External Content > Save Selection as Module... en kies *.pln als bestandsformaat.
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Bestanden splitsen

Bestanden splitsen

» via Menu File > External Content > Save Selection as Module... en kies *.pIn als bestandsformaat.
* Vink de optie ‘Replace selection with this hotlinked module file' aan indien het project dient gesplitst te worden

* |In beide bestanden verschijnt de melding ‘Splitting Project is completed’

Information

'I ! Splitting Project is completed.

 Kijk ter controle naar de Hotlink Module Manager in het hoofdbestand.



Archicafée XL -12

Touch Bar ondersteuning MacBook Pro

Toegankelijkheid
» Wisselen tussen Grondplan en 3D venster
- Show all vs. Show Selection 3D volgens willekeurige selecties van het model.
» Open actieve Gereedschapsinstellingen (Default / Selection).
» Open en sluit de Edit Mode voor Trappen, Relings en Gordijngevels.
» Bewerk Composieten of Profielen van het geselecteerde element.

» Toegang tot veelvoorkomende GDL shortcuts tijdens het bewerken van Scripts.

= = Settings.. [ Edit
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GRAPHISOFT GEBRUIKERSWENSEN

#1

H2

#3
#i

#5
#6

#/(

Handling of Dashed Polylines

at comers has been improved — now comers are dispiayed with proper dashes

regardiess of where the polyline starts or ends. Comers will display correct endings,
even after stretching.

Smart Parameter Transfer
allows filtering of parameter types to be transferred between elements. You an
even name, save and re-use previously configured parameter transfer sets.

New Distribute Along Path

command allows fast placement of similar elements along polygons - such as
lamps adjacent to a road. Use the new Random Placement option to scatter trees

OVer an area.

New 3D Styles
allow you to save 3D window settings and include them In your views. Changes to
3D Styles will automatically be applied to any views that use them.

Improved Magic Wand
provides graphical feedback on the results of an ongoing operation, saving you
editing time.

Improved Text Styles and Rich Text Formatting options
are now avallable for all text related tools - such as Dimension and Label Tools — to
nelp you create professional-looking detaill documents and drawings much faster.

Improved Section and Elevation Depth Control
and editing options and enhanced Range features help architects to fine-tune the

position and determine the e@act range of sections and elevations.

Archicafe XL -14
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Streeplijnen met gesloten hoeken

Polyline tool

- Keuze om hoeken al dan niet gesloten te laten weergeven

» Activeer de knop ‘By Segment’ in de Settings menu.

/7 GENERAL SETTINGS

Dashed

ey

—> >

ID AND CATEGORIES
Line Category
RENOVATION
Renovation Status

Show On Renovatio...

| Zone Boundary

—.1

CATEGORIES AND PROPERTIES

Drafting Line

Existing

All Relevant Filters

mim

-3

62

Archicafe XL -15
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Streeplijnen met gesloten hoeken

Algemeen N

» Een verbeterde 2D weergave waarbij de kans op open hoeken sterk
gereduceerd wordt.

» Automatisch gesloten hoeken bij Geprojecteerde weergaven.

» Een meer naturelle weergave bij Splines, aansluitende hoeken
en tangentiéle bogen.
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Selectief eigenschappen doorgeven

Element Transfer Settings

» Menu View > Element Settings > Element Transfer
Settings...

» Ter vervanging van de Favorites Parameter Settings.

» Keuze om parameters gefilterd door te geven van het
ene element naar het andere element met de
Injectiemethode (‘Spuit’).

» Instellingen kunnen opgeslagen worden als een Set.

* Import- en Exportmogelijkheden van deze Sets.

» Wanneer de Injectiespuit geactiveerd is het eenvoudig

tussendoor te wisselen van Element Transfer Set.

Archicafe XL -17

O Element Transfer Settings
Name A TS < Name: Editable: 1
Alle instellingen Alleen structuur / weergave / bibliotheek elementen
Alleen structuur / weergave [ bibliotheek...
NSRS (SN £ i | D Optional Settings to Include during Transfer: {é’} 4

Exclusief alle tekst

» [E ¢ All Other Settings
» ] @ Anchor Point

Exclusief bibliotheek elementen

Exclusief ID [ Laag

. > Classification
Exclusief metadata 0e

» [ @ Classification and Custom Properties
» @ Draining on Flight

Trap 2D symbool

Trap geometrie

Trap structuur [ afwerking » [ @ Draining on Landing

v[] @ Edge Angle
O {A Roof

» ¥ @ End with Riser/Run

» [ @ Endings and Connections

» [ @ Flight Structure Component Settings
» ¥ @ Floor Plan Display

» ¥ @ Handrail Component Settings

» M @ Handrail Connection Settings

» [ @® Handrail End Component Settings

» M @ Handrail End Settinas

New... Delete —@ G) Cancel
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Dupliceren met rotatie langs een pad

Multiply menu
« Verbeterd visueel overzicht van dit menu.

» Elementen kunnen tijdens het dupliceren geroteerd worden.

Multiply

& 4 ]

3

Rotate Elevate Matrix

Graphical Input Method:

-

r/’/'” ._/" # .—///#
Increment and Increment Spread Distribute
Spread g

Spacing:

0

Vertical Displac

Set Home Story by Elevation

Pick Path before Input Rotation of Copies:
f\ None

'/\' Rotate to Path

/—_ o Randomize
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3D Stijlen

3D Styles optie

O 3D Styles
Name A n Name: Editable: 1

o M eny DOC ume nt > 3 D Sty I es. . i Kleur - met arcering (Vectorial) Kleur - eenvoudig met schaduw

i Kleur - met schaduw (Vectorial)

% Lijnen - met arcering (Vectorial) ¥ GENERAL

- . o Lijnen (Vectorial) . -

+ Filter zichtbaar in 3D venter R 30 Engine: opencL Bo

@ Draadmoage! Transparency ﬁ ‘1” ‘E‘

i Kleur - eenvoudig

» Ter vervanging van de 3D Window Settings. - Surfaces:
i Kleur - gedetailleerd __J Monochrome Mode!
| o 3 — Contours:
- Eenvoudig veranderen van weergave stijl in het 3D venster. % Maguette - met schaduw . BACKGROUND

Sky Color:

» Uitgebreide mogelijkheden.

=)

Ground Color:

~ As in Photorendering

¥ CONTOURS
Show Contours Best
Contours: ST 1
Silnouettes: o --}- -
Vectorial Hatching: R [ [ ]'
——— / Shadow Contours: | -
= :E/ — » SHADOWS
=——————— » HOTSPOTS
% / New... Delete 2 3 Cancel
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Grafische feedback toverstaf

Magic Wand

* Preview van de te plaatsen elementen tijdens gebruik van de toverstaf.

» Mogelijk zowel bij 2D als bij 3D vensters
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Nieuwe opties voor tekststijlen

Tekst gerelateerde tools

» Text Style onderdeel beschikbaar bij:

» Eigen tekststijl favorieten aan te maken bij de Tekst Tool.

» Snelle toegang tot de tekststijl favorieten bij deze onderdelen.

» Tekst tool

- Labels

* Dimension tools

* [nteractive Schedules

Tekst groot

Tekst kader - standaard
Tekst kop Schedule
Tekst medium

Tekst standaara

E Favorites

350
mim

Tekst groot

2,50
mm

Tekst kop Schedule

W 9

1,80
mm

Tekst kader - standaard

2,90
mm

Tekst medium

Archicafe XL -21

O Text Default Settings
&> Pxd Default
v [AY TEXT STYLE
Arial v
M.1 180 mm A L3 | N
Leading: $a 100 - %
B / U F
Width Scale: &5 100 s %
- — & Spacing Scale: A4 100 S %
v YA TEXT BLOCK FORMATTING
Anchor Point: : N : | Opaque 1
. - 4 -
Relative > Frame Al L
V|00 ,,
al mm
Z& | | Fixed Angle
A 2 Always Readable ~ Model Size
@@ | Wrap Text o Paper Size
¥ |=£/ PROPERTIES
v RENOVATION use Palette to set default
Renovation Status
Show On Renovation Filter
)
<& Tekst/dim 1: 50/100 > Cancel OK
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Doorsnedes en Gevels

Section & Elevation view
» Mogelijkheid om Doorsnede- en Gevelzichten rechtstreeks in deze vensters in te stellen.
» Grafisch begrenzingslijnen in hoogte en breedte aanpassen.

» Grafisch breekpunten verleggen.

* Niet nodig om naar het grondplan terug te keren. | S | | |
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Doorsnedes en Gevels

Section & Elevation tool
« Mogelijkheid om achteraf eéén of meerdere breekpunten toe te voegen met behulp van het Petpalet
» Breekpunten kunnen ook toegevoegd worden bij de ‘Limit Line' en bij * Marked Distance Area Line'.

 Gebruik ‘Insert break and offset’ (1) om Gevel- en/of Doorsnedemarkerlijnen op te splitsen 1 2

v %
» Gebruik ‘Insert break and offset on all lines' (2) om Gevel- en/of Doorsnedemarkerlijnen samen ’%]
met de ‘Limited Depth' markeringslijn op te splitsen. 3 O 74
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Glas-op-Glas hoekaansluiting

Raam gereedschap

» Mogelijk bij alle raamtypes.

» Enkel bij openingstype ‘vast glas’.

v 5 INSTELLINGEN RAAM

4 | I ] =4 | ’;STEHoekaansluiting... >

Type hoekaansluiting Glas a Kader
Hoek kolom

Eigen hoek 2  Eigen hoek 1
S ——————

=l

| Aansluiting afhankelijk van Aansluiting afhankelijk van
wanddikte wanddikte
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Zonpositie met datum en tijd instelbaar per 3D venster

Camera tool en 3D Projection Settings

» Verschillende Datum- en tijdinstellingen kunnen in views bewaard worden.

» Stel deze af in het 3D venster en sla de view op.

* Onderin het menu van ‘Create view' of bij de ‘View Settings' van deze view kan de

datum- en tijdsinstelling afgelezen worden.

Archicafée XL -26

O View Settings

Get Current Window's Settings Selected: 1, Editable: 1

» IDENTIFICATION

» GENERAL

» 2DJ/3D DOCUMENTS

¥ 3D ONLY

Filter and Cut Elements in 3D...

(O] Generate in: 3D Window

(9 3D Style: Kleur - eenvoudig met schaduw

i Rendering Scene: Start KME

Engine: CineRender by MAXON

] Size: — 1 pX > dpi >

3D view not limited by either selection or Marguee.

Render Safe Frame is not applied.

Image settings are stored with the view:
- 3D Projection/Camera settings (including zooming)

- Date and Time (August 28, 16:15:40)

- 3D Cutaway and Cutting Planes

| Redefine Image Settings with current
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Extra punten toevoegen aan ronde randen

Petpalet

» Met de knop ‘Insert new node to arc'.

[EN

2
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Renovatiestatus als filterelement in GOC

Graphic Override Combinations

» Renovatie statussen kunnen gebruikt worden als criteria.

* Ingebouwde Renovatie Regels (1) blijven onveranderd, met een vaste Criteria set.

Alle achtergrondarceringen...

Alle achtergrondarceringen...

Alle Cover Fills - Dichte arce...

A
A
A
A

le Cover Fi
le Cover Fil
e Cover Fi
e Cut Fills

s - Grijs
s - Lege arceri...

's - Transparant

- Gevuld
Alle Cut Fills - Gevuld met |a...

Alle Cut Fills - Gevuld zwart

[
[]
|
|
|

Name:

Bestaande muren

¥ CRITERIA

Criteria

Element Type

IS

Graphic Override Rules

Renovation Sta... Existing

Add... >

Remove

Archicafée XL -28

Editable: 1

To Be Demolished

New

T—

———
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Nieuwe Zone stempel

Zone Stempel 21 KM

- Meer inhoudelijke opties om te tonen, zoals:

» Gemeten netto en gereduceerde
opperviaktes

» Afwerkingen uit keuzelijst
» Peilmaten
» Bezetting voor PVE en normering
* ARCHICAD Properties
» Classificaties

» Mogelijkheden om nummer zelf samen te stellen

» Gegevens uit PvE add-on wordt opgenomen
In de zone stempel

» Koppeling met MVOC uitgebreid met een splitsing
tussen inhoud en opmaak

Archicafe XL -30

v INSTELLINGEN ZONE STEMPEL

Inhoud en volgorde > >> MVOC: Inhoud @ Opmaak (i)

| Toon peilmaten en nummer Zone samen

Toon ID appartement in apart kader

> 1. Naam Zone

> 2. Nummer Zone

v 3. Oppervlakten Zone

Gemeten oppervlakte
Gemeten netto oppervliakte
Gereduceerd opperviakte

Berekend oppervlakte
PVvE opperviakte

> 4. C(Classificatie en Properties
S. **|ege rij
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Programma van Eisen

PvE Add-on MINIMALE LOKAALOPPERVLAKTE, AFMETINGEN & BEMEUBELBAARHEIDSCRITERIA
m
. . . Inkomhal 21,5 m - 150X100 / - vestiaire(kast) min. 6ox60 c¢m
* Programma van Eisen wordt verwerkt in een speciale spreadsheet template Leefruimte | 2 20 m* + 2 m* per persoon | - zitzone min. 360 cm breed - zitelementen BoxBo cm
- eetzone min. 320 ¢cm breed - aantal zitplaatsen 2 aantal bewoners,
minimaal 4
» Plaats in één keer meerdere zones + tv-meubel 200x50 cm
inclusief: _ - eettafel 18oxgo cm
. . . Keuken 2 4 m° + 0,5 m’ per persoon | - vrije afstand tussen evenwijdige | - koelkast 60 ¢cm
i C a te g orie co d € (r uim t € g € b Ul k) aanrechtzones: min. 100 cm - fornuis 6o cm, afzetzone links of
_ Help. .. - bruikbare maatverhoudingen: rechts 2 60 ¢cm
O p p erv | a kte In?op 18ox240 [ 18ox300 [ 240x240 - dubbele spoelbak + verlek 120 cm,
- Minimale breedte (marge op deze afmetingen te afzetzone links en rechts 2 30 cm
) voorzien) - aanrechtzone 180 cm
- Bezettlng NOoIrm - totaal incl. koelkast: 420 cm
_ Ge|U|d en Ontwerptemperatuur Slaapkamer | 212 m’ - 340x360 [ 280x420 /[ ... -bed16ox2.05cm
ouders - nachtkastjes
- Eenheidsprijzen s P S
. 3 . . . . | | - vrije gebruiksruimte min. 8o cm
- Eigen teksten en/of waardes (bijvoorbeeld voor inventaris of extra eisen)  [sespkemer |28 m ( kind - breedte min. 220 cm - per kind: bed gox205 cm, kast
kind(eren) 2 14 m* (2 kinderen) - 240x360 [ 260x320 [ 280x300 100x60x200 ¢m, bureau 120x70 cm,
/.. nachtkastje
e Automatische nummering _ _ | - vrije gebruiksruimte: min. 8o cm
Berging 2 1,5 m’/pers - 150x100 [ 120%120 [ ... - wasmachine, droogkast, cv, ...
Badkamer 23 m’ + 0,5 M per persoon | - 170x240 [ 170x270 [ 215x215 / - tweede wastafel en ligbad vanaf 3
- Automatisch juiste categorie en plaatsing op juiste verdieping sloapkamers

» (Geplaatste zones kunnen doorheen alle fases blijven gebruikt worden
» Qorspronkelijke oppervlakte-eis blijft oproepbaar

» Schedules In functie van van Kostenraming, bezetting Norm en Ontwerp en Programma van Eisen
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Update Schedules voor de Digitale bouwaanvraag of de Omgevingsverqgunning

Schedules
. . v t] BA - Bouwaanvraag
» Nieuwe opzet te verzamelen gegevens nodig voor het samenstellen v ] FRM Formulieren
van het vergunningsdossier. TH OMG-ALG Zones info checklist
TH OMG-ALG Zones m2 per Hoofdfunctie
+ Gebruik Favorieten bij het Morph- en Zonegereedschap. W CRAR = Ml isriatts Oafonion
OMG-BKG 01 Bovengronds - Grondopperviakte
. . . o . . TH OMG-BKG 02 Bovengronds - Nuttige opperviakte van het volledige Gebouw
* Gebruik onderstaande Properties in het menu ‘Classifications and Properties'’ T OMG-BKG 03 Bovengronds - Totaal volume
van de Zone Settings: 1 OMG-BKG 04 Ondergronds - Grondoppervlakte
H OMG-BKG 05 Ondergronds - Totaal volume

: : s . . OMG - Detall Inf '
* Gebruiksfunctie BE : Keuzemenu, zoals 1 Wonen - Eengezinswoning IR UMD = Dkl iy
OMG-DI CO1 Commerciéle functie

(Zle Dlg Itaal LOket) TH OMG-DI C02 Commerciéle functie - Publiek Toegankelijk

» Soort gebied : Privaat, Openbaar, Semi-openbaar -

OMG-DI 101 Industriéle functie - Productie / opslag goederen

OMG-DI 102 Industriéle functie - Ondersteunende functies

OMG-DI O01 Openbare voorzieningen

» Recreatiefunctie : te gebruiken submenu indien gebruiksfunctie '‘Recreatie’ val 05
toepassing is -

OMG-DI PO1 Publieke Voorziening - Parkeergarage

OMG-DI P02 Publieke voorzieningen - Aantal Verblijven

o q:n MAAT _ NI DNT Damsramstimuns frimmdisn - A s t ' V bl“
» Vloeropening > 4m2: True / False v ALGEMENE EIGENSCHAPPEN ntal Verblijven
. , ttige viceropperviakte
(b Bezetting Gebruik 'Bezetting' in Zone Stempel | i
- De schedules maken gebruik van deze properties. ., Gebruiksfunctie BE 1 Wonen - Eéngezinswoning bliek Toegankeljk
=5 Soort gebied n.v.t.
- OMGEVINGSVERGUNNING .

. . elen Toilet (objecten
(&> Recreatiefunctie n.v.t. REL ROt} )
. tganagen
‘@& Vioeropening > £4m2 False .
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Nieuwe favorieten Vlaanderen / Belgié

Raam- en Deurgereedschap

» Verder verfijnd + extra favorieten aangevuld

Digitale bouwaanvraag / Omgevingsvergunning

|\E|Favorites
* Morph 'Z Morph BA'
» Zones met diverse categorieén
 |n functie van de Schedules te gebruiken
Ki m b I O k Badruimte KME Berging KME
» Favoriet bij het Balk gereedschap '21 Kimblok in Cellenbeton’
Buitenruimte KME Circulatie hor. KME

Circulatie horz Circulatie ver. KME
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Overig

Object Label

» Mogelijkheid om in het model te controleren als wanden ‘netjes’ zijn getekend

-
<7

Object label 21

KM

2,489553

» (update) Mogelijkheid om profielen automatisch te tonen

HEM 320

v M SYMBOL LABEL

Parameters

Vorm label
Afmeting label
Inhoud label
Label orientatie
Labe! Tekst

» 2D symbool

v ™ sYMBOL LABEL

Parameters

Vorm label
Afmeting label
Inhoud label
Label orientatie
Label Tekst

» 2D symbool

Object ID
Rechthoek Afmetingen

Object Naam l

Automatisch  Positie | @
Staalprofiel Staalprofiel [

Altiid leesbaar Eigen

Laag Llative >
L ———
Zonenaam

Zonenummer
Uitlezen GDL parameter olor
v Controleren hoeken

Object Naam
Object ID

Rechthoek Afmetingen

Automatisch Positie [P
Staalprofiel EAACELUE N

Altijd leesbaar Eigen
Laag Lf
Zonenaam
Zonenummer
Uitlezen GDL parameter
Controleren hoeken

Archicafe XL -34
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BB/SfB 3-4 cijfers Elementencodering

ogo o O Window Default Settings
ClaSSIflcathn B Y% Q B> Y m21 Default
Embedded Library v [[@ PREVIEW AND POSITIONING
v Linked Librarie.s | @ 50,00 : =
» Keuze maken bij het onderdeel ‘Classification and Properties'’ LR s e @: . o®
» £ 21 wanden 21 ] — ’ @
van het Element zelf. e preners =I= 3
P 01 Ramen 21 - Sill to Story 0 > @
g 02 Schuiframen 21 :: 80,00
. ro . ; s ] 03 Ronde ramen 21 Reveal to Wall Face >
» Meerdere Classificaties kunnen aan eén element gekoppeld B 04 Morummentae ramen 21 FZ.  |sso

Q
| F = O- TERREINEN, PROJECTEN
worden. £ 06 Puien 21 atex o2 v R | v/l

» %) 1- BODEM, ONDERBOUW

] 07 Overige ramen 21

P 08 Raamopeningen 21 v B3 INSTELLINGEN RAAM » %) 2- PRIMAIRE ELEMENTEN VAN BOVENBOUW
£ 3D openingen 21 4 | » [ [ Raaminstellingen en openingen... v %) 3- SECUNDAIRE ELEMENTEN, AFSLUITENDE ELEMENTE}
° Men U OptIOﬂS > ClaSS|f|Cat|On Ma nager,,, TR it Type opening v %) 31- SECUNDAIRE ELEMENTEN VOOR BUITENWANDEN
Hoofd Draaidee! % 31.3 DEUREN, RAMEN, RAAM-DEUREN, RAAM-EN-C
Ny

g @ 31.3- RAAM-DEUREN, OPENINGEN VOOR RAAM-DE
&3 31.4 RAMEN, OPENINGEN VOOR RAMEN, RAAMOPE
> @ 31.4- RAMEN, OPENINGEN VOOR RAMEN, RAAMOP
&% 31.5 31.5 DEUREN, OPENINGEN VOOR DEUREN, DO

R121 R1 bl ol 121 21 i » %) 31.5- 31.5 DEUREN, OPENINGEN VOOR DEUREN, D(
= % 31.7 LUIKEN, OPENINGEN MET OF ZONDER LUIKEN

Detailniveau | Ventilatierooster
3D detailniveau Gedetaile.. & R | » %) 31.7- LUIKEN, OPENINGEN MET OF ZONDER LUIKE}
2D detailniveau Volgens M... & @ % 31.8 HOGER NIET GENOEMDE ELEMENTEN VAN 31-
I % 31.9 HULPSTUKKEN EN ONDERDELEN VOOR ELEME

I E FLOOR PLAN AND SECTION

» %) 32- SECUNDAIRE ELEMENTEN VOOR BINNENWANDEN

» ¥f DIMENSION MARKER

R2 bl ol 21 R2 stolp bl ol 21 e — » %) 33- SECUNDAIRE ELEMENTEN VOOR VLOEREN
S e S % 34 SECUNDAIRE ELEMENTEN VOOR VERTICALE CIRCL
CLASSIFICATIONS » %) 35- OPGEHANGEN PLAFONDS
@ ARCHICAD Classification... Raam » %) 37- SECUNDAIRE ELEMENTEN VOOR DAKEN
e e B % 38 HOGER NIET GENOEMDE ELEMENTEN VAN 3-
% 39 HULPSTUKKEN EN ONDERDELEN VOOR ELEMENTE

R3 bl midden 21 R3 bl ol 21 » %) 4- AFWERKING
° » %) 5- TECHNISCHE UITRUSTING HOOFDZAKELIJK FLUIDA
v ID AND CATEGORIES
o orkx » %) 6- TECHNISCHE UITRUSTING HOOFDZAKELIJK ELEKTRI
Structural Function Non-Load-Bearing Element » %) 7- VASTE INRICHTING
Position Interior » %) 8- LOSSE INRICHTING
v RENOVATION use Palette to set default

> @ 9- ELEMENTEN BUITEN HET GEBOUW, HOGER NIET GEN

Renovation Status

R3 bl zijkanten 21 Rmeerkeuze 21 Show On Renovation Filter

EE_‘ > Empty Opening Cancel OK




Archicafé XL -36
ARCHICAD 21 - KEYMEMBER EDITIE

Meer

Upgrade Webinar

Volg de Upgradewebinar live op:
» donderdag 14 september om 15:30
» dinsdag 19 september om 10:30
» inschrijven via http://www.kubusinfo.be/Support/Cursussen/ArchiCAD/Upgraden
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